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LIST OF EXPERIMENTS 
 
 
 

No. Title 

1 Build a Virtual instrument that simulates a heating and cooling system. The system 
must be able to be controlled manually or automatically. 

2 Build a Virtual instrument that simulates a basic calculator. 

3 Build a virtual instrument that simulates a water level indicator. 

4 Demonstrate how to create basic VI which calculates area and perimeter of a circle. 

5 Simulated AI and AO for Temperature Control System  

6 Tank Level Control using PID 

7 Simulated DI and DO for two-tank control system using Fuzzy Controller 



 
 

EXPERIMENT 1 

 

BUILD A VI THAT SIMULATES A HEATING AND COOLING 
SYSTEM.THE SYSTEM MUST BE ABLE TO BE 
CONTROLLED MANUALLY OR AUTOMATICALLY. 

 
AIM: 

To build a VI that simulates a heating and cooling system. The system must be able to be 
controlled manually or automatically. 

The VI’s specifications are listed below. 
 

 Must be able to be controlled automatically or manually 
 In manual mode, the heater and air conditioning (AC) can be switched on/off by the 

user 
 In automatic mode, the heater and AC turn on/off based on the following conditions: 

o The air conditioner is turned on when the temperature is above 80°F 
o The heater is turned on when the temperature is below 60°F 
o The heater and the air conditioner are turned off when the temperature is between 

60°F and 80°F. 
 

THEORY: 

Structures are process control elements, such as while loops and for loops. The structure to be 
used in this experiment is the case structure which is essentially multiple if-statements. A case 
structure contains multiple subdiagrams (or cases), and a case will be executed depending on 
the input to the case structure 

 
PROCEDURE: 

1. In the front panel, drag and drop three Round LEDs and three Slide Switches by going to 
the Controls palette > Modern tab > Boolean. Each round LED and each slide switch will 
represent the AC, heater, and manual mode. The round LEDs will indicate if the item is on, 
and the slide switches will toggle the items on/off. 

 
2. Rename the LEDs and their corresponding switches "Manual," "AC," and "Heater" to make 

building the system clearer. This can be done by using the editing text tool in the Tools 
palette. 

 
3. Drag and drop a thermometer into the front panel (Controls palette > Modern tab > Numeric 

> Thermometer). 
 

4. In the back panel, right click the thermometer terminal and select Change to Control, and 
observe how the arrow switches from the left side to the right side. This makes the 
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thermometer a control that will give an input to the program, which in this case is 
temperature. 

 
5. In the back panel, insert a case structure to control the manual and automatic operation of 

the heating and cooling system (Functions palette > Structures > Case Structure). To place 
the case structure, click once to place one corner of the case structure, and once more to 
place the other corner of the case structure. 

 
6. Wire the slide switch designated as Manual to the case selector on the case structure. This 

should automatically change the selector label values to True and False, if they were not 
already, because the slide switch is a Boolean data type. The true value corresponds to 
manual mode being on (where the user can directly toggle the heater and AC), while the 
false value corresponds to manual mode being off (where the heater and AC are 
automatically toggled by the system). 

 
7. Because the temperature of the room is input into the system only when the system is not in 

manual mode (the false case), the thermometer terminal should be moved into the false sub- 
diagram. 

 
8. In the true sub-diagram, wire the AC and heater switches directly to their corresponding 

LEDs. This allows the switches to directly toggle their corresponding LEDs. 
 

9. Staying in the true sub diagram, insert a True Constant (Functions palette > Programming 
tab > Boolean > True Constant). Wire the true constant to the manual LED to turn the 
manual LED on and indicate that the system is in manual mode. 

 
10. In the false sub diagram, insert two Numeric Constants (Functions palette > 

Programming > Numeric > Numeric Constant), one Greater? function and one Less? 
function (Functions palette > Programming > Comparison). These will be used to build the 
program for the heating and cooling system in automatic mode. 

 
11. The less and greater functions compare what is wired to the upper input terminal to what 

is wired to the lower input terminal. Wire the thermometer to the upper input terminals of the 
less and greater functions. Set a numeric constant to 60 and the other to 80. Wire the 60 
numeric constant to the lower input terminal of the less function and the 80 numeric constant 
to the lower input terminal of the greater function. Wire the output terminal of the greater 
function to the AC LED and wire the output of the less function to the heater LED. 

 
12. In the false sub diagram, Insert a False Constant (Functions palette > Programming > 

Boolean > False Constant) and wire it to the manual LED. This is to turn off the manual 
LED and indicate that the system is in automatic mode. 

 
13. The system is now complete. Click the continuously run button to control and test the 

VI. If the continuously run button is faded out, that means the system is wired completely. 
When successfully running the system, the gridlines in the background of the front panel 
should disappear. Click the switches and thermometer on the front panel to test the system. 
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BLOCK DIAGRAM: 

Fig 1.1 and 1.2 shows the block diagram for true case and false case respectively. 

 
 

 
Fig 1.1 Block Diagram – For True Case 
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Fig 1.2. Block Diagram – For False Case 
 
 

 
OUTPUT/FRONT PANEL: 

The output for VI simulating a heating and cooling system is shown in Fig 1.3. 
 
 

Fig 1.3.output 
 

 
RESULT: 

A virtual instrument that simulates a heating and cooling system is built. 
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EXPERIMENT 2 

BUILD A VIRTUAL INSTRUMENT THAT SIMULATES 
BASIC CALCULATOR USING FORMULA MODE 

 
AIM : 

To build a Virtual Instrument that simulates basic Calculator Using Formula Mode. 

THEORY: 

The Formula Node in LabVIEW software is a convenient, text-based node you can use to 
perform complicated mathematical operations on a block diagram using the C- syntax structure. 
It is most useful for equations that have many variables or are otherwise complicated. The text- 
based code simplifies the block diagram and increases its readability. Furthermore, you can 
copy and paste existing code directly into the Formula Node rather than recreating it 
graphically. The Formula Node is available in all development versions of LabVIEW and does 
not require an additional toolkit or add-on. 

 
PROCEDURE: 

 

1. Selecting File»New VI to open a blank VI. 
2. Place a Formula Node on the block diagram. 

1. Right-click on the diagram and navigate 
to Programming»Structures»Formula Node. 

2. Left-click to select the Formula Node. 
3. Place the Formula Node on the block diagram by left-clicking, dragging, and 

releasing the mouse. 
3. Right-click the border of the Formula Node and select Add Input from the shortcut 

menu. 
4. Label the input variable x. 
5. Repeat steps 3 and 4 to add another input and label it y as in fig 2.1. 

 

 

Fig.2.1 add input 
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5. Right-click the border of the Formula Node and select Add Output from the shortcut 
menu as in fig 2.2. 

 

Fig.2.2. add output 
 

6. Label the output S1. 
7. Repeat step 5 to create another output, and label this output D1 

 
8. Enter the expressions below in the Formula Node. 

 Make sure that you complete each command with a semicolon. Notice, 
however, that the if-statement does not require a semicolon on the first line. 
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Fig 10.7 output 

 

 
 
 
 
 
 
 
 
 

 

Fig 2.3 Block diagram 
 

 
OUTPUT/FRONT PANEL: 

The front panel view is shown in following Fig. 2.4 
 

RESULT: 

A virtual instrument that simulates a basic calculator is built. 

QUESTIONS: 

1. What is the formula node? 
2. Use formula node for finding area of circle, circumference of circle and arc of a circle 
3. What is the advantage of using formula node? 
4. Is formula node text based or block (graphical) based? 
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EXPERIMENT 3 

WATER LEVEL INDICATOR 

 
AIM: 

To create and demonstrate water level indicator. 

Description: 

If No water is in tank then motor must be ON. 

If water level crosses 8 then Motor must be OFF. 

THEORY: 

The water level indicator circuits are used in factories, chemical plants, and electrical substations and 
in other liquid storage systems. There are many possible uses for this simple system, examples include 
monitoring a sump pit (to control pump activation), rainfall detection, and leakage detection. Electronic 
water level circuits have the capability of alerting if there is a water leak somewhere in the factory. 
When the water level is too high or too low or exceeds the higher limit, it can detect the water level 
easily by hearing an alarm sound or from different colors of a light bulb. We can also measure the fuel 
level in motor vehicles and the liquid level containers which are huge in the companies. 

The circuit is designed to indicate three levels of water stored in the tank: empty, half and full but not 
overflowing. When there is no water in the tank, all the LEDs are off as an indication that the tank is 
completely empty. Then, manually control the knob to turn ON LED. When water level increases and 
touches the maximum limit, the OFF LED will glow indicating that there is water within the tank. As 
the water level continues to rise and reaches half the tank, ON LED will still glow indicating tank is 
filling. 

The important LabVIEW components or tools, required to design a water level detector, list of 
these components below: 

 Tank 

 Round Knob 

 Upper Level Indicator 

 Lower Level Indicator 

 Numerical Indicator 

 Graph to observe the results 
 

Vertical pointer is used to control the level of the water in the tank. Upper level indicator shows 
when the tank is about to completely fill. Lower level indicator shows indication by turning "ON" 
the LED when the level of the water in the tank is too low and we need to fill it. Graphs shows the 
graphical visualization as the vertical pointer moves up ow down. 
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PROCEDURE: 

Step 1: Create blank VI. 

Step 2: Right click on the front panel →numeric→ knob. 

Step 3: Right click on the knob →Properties→ scale→ Set maximum 10 and minimum 0 

Step 4: Right click on the front panel →Boolean→ Round LED (Name it ON). 

Step 5: Right click on the front panel →Boolean→ Round LED (Name it OFF). 

Step 6: Right click on the front panel →numeric→ Numeric control 

Step 7: Right click on the front panel →numeric→ Tank 

Step 8: Right click on the Block diagram panel →comparison→ greater or equal? 

Step 9: Right click on the Block diagram panel →comparison→ less? 

Step 10: Right click on the Block diagram panel → numeric→ Numeric constant (set 8) [twice] 

Step 11: Using wiring operations required connections are made as given in the block diagram. 

Step 5: Execute- give inputs in the front panel by rotating knob and observe tank filling and 
switches ON & OFF. 

BLOCK DIAGRAM: 

Fig below shows the block diagram water level indicator in LabVIEW. A round control knob is 
used to switch on the motor and off. Numeric indicator display water level in tank. 

 

Block diagram 
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OUTPUT /FRONT PANEL : 

 

 
 
 

 
RESULT: 

Fig shows motor on with no water and filling and reached upper limit and off. A VI that 
indicates water level is built. 

QUESTIONS: 

1. How to create vertical indicators? 
2. Is it possible to change the settings of LED? 
3. Is it possible to implement this using While loop? 
4. Comparator functions are present in which palette? 
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EXPERIMENT 4 

CALCULATION OF AREA AND PERIMETER OF CIRCLE 

 
AIM: 

To calculate area and perimeter of a circle. 

Description: Area of circle = 𝜋𝑟2 

Perimeter/circumference of circle = 2𝜋𝑟 

 r- radius of circle 

   if r>10 then indicate to reduce radius. 

THEORY: 

The area shows the space inside an object having two dimensions. Where as, circumference is 
the parameter which shows the boundary of the object. Area is usually measured in m² and 
circumference is measured in m according to their System International (SI) units. In this area 
and area and circumference calculation of circle is achieved. In this LabVIEW program, which 
will take radius as an input and calculates the area and circumference of circle, You can also 
select the maximum limit of the radius. When the radius approaches its maximum limit an LED 
will glow showing the notification reduce the radius. 

PROCEDURE: 

Step 1: Create blank VI. 

Step 2: Right click on the front panel → numeric→ Numeric control 

Step 3: Right click on the front panel → numeric→ Numeric indicator [Name Area] 

Step 4: Right click on the front panel → numeric→ Numeric indicator [Name Circumference] 

Step 5: Right click on the front panel → Boolean→ Square LED 

Step 6: Right click on the Block diagram panel →Numeric→ multiply (thrice) 

Step 7: Right click on the Block diagram panel →structures→ while loop 

Step 8: Right click on the Block diagram panel →numeric→ numeric constant [set value 10] 

Step 9: Right click on the Block diagram panel →numeric→ numeric constant [set value 2] 

Step 10: Right click on the Block diagram panel →numeric→ math constants→pi 

Step 11: Using wiring operations required connections are made as given in the block diagram 
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BLOCK DIAGRAM: 

Fig 4.1 shows the block diagram of area and circumference of circle in LabVIEW. Area and 
circumference is calculated using formulas. An upper limit to radius is also kept here. 

 
 
 
 

 
 

Fig.4.1 block diargram 
 

 

OUTPUT /FRONT PANEL : 
 
 

 

 
RESULT: 

 
 

Questions: 

1. What are the units of area and perimeter? 

2. Where to select pi function? 

3. What is the difference between continuous run and run? 

4.  How to indicate broken wire in LabVIEW? 

 
 
 
 
 



 

EXPERIMENT 5 

SIMULATED AI AND AO FOR  

TEMPERATURE CONTROL SYSTEM 

 
Temperature Monitoring demonstrates a temperature monitoring application.  The main VI reads a 

simulated temperature and alarms if it is outside a given range.  

 

 
 
Instructions: 

1. Run the VI. (Industry Applications > Temperature Monitoring.lvproj) 

2. Click the Start button to start monitoring temperature data. 

3. Click the Stop button to stop monitoring temperature data. 

4. Change the temperature so the alarm is activated when the temperature is greater than 90 F?  

5. Click Exit to stop the VI. 

6. Give comment on the simulated input and output of the experiment. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

EXPERIMENT 6 

TANK LEVEL CONTROL USING PID 
 

This example demonstrates a process simulation for a tank level.  The process has added noise, valve 

deadband, lag, and deadtime.  A level controller adjusts the inflow to a tank.  An on/off valve serves as a 

drain that you can click on to operate.  This s-valve represents a change in the process loading.  You also 

can switch this VI from automatic control to manual control. 

 

 
Instructions: 

1. Run the VI. (Control and Simulation > PID > Simulation – Tank Level.vi) 

2. Verify the PID controller in closed-loop to track the setpoint. 

3. Change the setpoint to another value and verify the controller tracking the new setpoint. 

4. Apply a disturbance to the system by switching the valve HV 102 (click on the valve symbol). You will 

see the controller recovering from the change. 

5. Change PID gains and see if you can improve its performance without going unstable. 

6. Switch to manual mode and see if you can control the level by changing the Valve LVC 101. 

7. Click Stop to stop the VI. 

8. Give comment on the stability of the system.  

 
 



 

 
 
 

EXPERIMENT 7 

SIMULATED DI AND DO FOR TWO-TANK CONTROL SYSTEM  

USING FUZZY CONTROLLER 
 
This example simulates a two-tank system with a fuzzy controller.  The system is two tanks of water with 

a small orifice between the tanks at the bottom of both (height = 0 m).  The second tank has another small 

orifice at the tank bottom that empties into a reservoir at a lower height than the two tanks.  The initial 

properties of the tanks and orifices are shown on the front panel controls below each tank. The goal of the 

simulation is to control the height of tank 2 to the user-specified height setpoint.  The control value is the 

flow rate into tank 1.  Therefore, this system is a second-order control system. 

 

 
 
 
Instructions: 

1. Run the VI. (Control and Simulation > Fuzzy Logic > FuzzyEx Tanks with PI control.vi) 

2. Change the Tank 2 Set Point and see the Fuzzy Logic System Controlling input valve to set the Flow 

Rate In. 

3. Click Stop to stop the VI. 

4. Give comment on the stability of the system.  


